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1iPlus Ver. 2.1-VI (Answer Key)

	 �Categories of Computers and Computer 
Languages

Let's Catch Up (Page 12)

	 1.	 Hybrid	 2.	 Tablet	 3.	 Supercomputers

Exercise
Section A (Objective)

A.	 1.	 c 	 2.	 b 	 3.	 a	 4.	 c	 5.	 d
B.	 1.	 terminals			   2.	 Automated Teller Machine
	 3.	 Machine 	 4.	 Smartwatch 	 5.	 Analog
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 F

Section B (Subjective)

A.	 1.	 Low-Level Languages (LLL), such as Machine Language (1GL) and Assembly Language (2GL), 
are also known as native languages.

	 2.	 An assembler is a program used to translate assembly language (LLL) into machine language 
so that the computer can understand it. 

	 3.	 Natural languages are the programming languages that have visual tools to develop a 
program. Example: Mercury.

	 4.	 PARAM was India’s first supercomputer, developed in 1991. 
B.	 1.	 A language translator is software that converts a high-level language program into a machine 

language that computer understands. Three types of language translators are:
		  a.  Assembler 
		  b.  Compiler 
		  c.  Interpreter 

1.
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	 2.	 A digital camera captures image or picture momentarily and converts the image directly into 
digital form and stores in memory. It can then be viewed on the computer or compatible 
devices. 

	 3.	 Low-level language is machine-dependent and requires an assembler, whereas high-level 
language is machine-independent and requires a translator.

	 4.	 Computer Languages

Machine 
Language (1GL)

Assembly 
Language (2GL)

Third Generation 
Language (3GL)

Fourth-Generation 
Language (4GL)

Natural 
Language (5GL)

Low-Level Language High-Level Language

	

C.	 1.	 Yes, a desktop is a better option for online studies because it has a bigger screen, a stable 
internet connection, and better storage capacity compared to a tablet.

	 2.	 Akriti’s teacher has used a third-generation language (3GL) because C++ is a procedural 
and object-oriented programming language.

Higher Order Thinking Skills (HOTS)
	 1.	 The hospital should use a hybrid computer because it combines the speed of an analog 

computer (for real-time monitoring), and it provides the accuracy of a digital computer (for 
data processing).

	 2.	 High-level languages have simplified programming by making it more user-friendly and 
efficient. Programmers can write complex programs faster and with fewer errors.

Crack The Code
	 1.	 4GL
	 2.	 3GL
	 3.	 5GL
	 4.	 3GL
	 5.	 4GL
	 6.	 5GL
	 7.	 3GL
	 8.	 3GL
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 File Management—Organisation of Data

Let's Catch Up (Page 24)

Step 5:	 Click on the Cut command.
Step 7:	 Click on the Paste command.
Step 2:	 Click on File Explorer.
Step 6:	 Click on the drive where you want to move the file or folder.
Step 4:	 Select the file.
Step 1:	 Click on Start Button 
Step 3:	 Select the drive and folder where file/folder to be moved is located 

Exercise
Section A (Objective)

A.	 1.	 b 	 2.	 c 	 3.	 b	 4.	 a	 5.	 d
B.	 1.	 Data	 2.	 files, folders	 3.	 Drives	 4.	 names	 5.	 Pen drive
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 F	 5.	 T
D.	 1.	 b	 2.	 d	 3.	 e	 4.	 c	 5.	 a

Section B (Subjective)

A.	 1.	 The View menu/tab has the Sort by command.

	 2.	 The Show windows side by side option is available in the Taskbar.

	 3.	 A computer hard disk is found inside the CPU box. 

	 4.	 The file type is also called the file format. The file format can be determined by the file 
extension. 

B.	 1.	 Wildcard characters are special character that are used to represent one or more characters. 
They are used to search files/folders. Two wildcard characters are commonly used for 
searching files/folders in a system. 

	 2.	 The steps to copy a file from pen drive to your computer are:

		  Step 1:  Insert the pen drive into the USB port.

		  Step 2:  Click on the notification that appears.

		  Step 3:  Select Open folder to view files option.

2.
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Crack The Code

	 1.	 S O R T I N G

	 2.	 E X P L O R E R

	 3.	 F O L D E R

	 4.	 F O R M A T

	 5.	 S T O R A G E

	 6.	 D R I V E

	Word Processor—Tabular Representation

Let's Catch Up (Page 35)

Step 1:	 Insert	
Step 2:	 Table	
Step 3:	 Insert Table	
Step 5:	 OK

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 b 	 3.	 b	 4.	 b
B.	 1.	 right-pointing	 2.	 select	 3.	 rows, columns
	 4.	 organise			   5.	 Spin box
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 T	 5.	 T

Section B (Subjective)

A.	 1.	 A table is a grid of boxes framed by horizontally aligned rows and vertically aligned columns 
that help to organise data. 

	 2.	 To select an entire row, move the mouse pointer outside the left edge of the first cell in the 
row. The pointer will become a black right-pointing arrow. Click to select the entire row.

3.

		  Step 4:  Choose the file or folder to copy.

		  Step 5:  Click on the Copy command.

		  Step 6:  Select the drive where you want to save the file.

		  Step 7:  Click on the Paste command.

		  Step 8:  Click on Eject before removing the pen drive.

	 3.	 When we copy a file or folder, the original file or folder remains at the original location and 
a duplicate of it is created at a new location, whereas when we move a file or folder from 
one drive to another, the file or folder is removed from its original location and moved to a 
new location. 

	 4.	 Different sorting options are:

		  1.	  Sorting by Name 

			       Sorting by Name allows us to arrange the files alphabetically. 

		  2.  Sorting by Size 

		        �Sorting by Size arrange the files and folders as per their size. Starting from the lowest 
size to the highest size, or vice-versa. 

		  3. 	 Sorting by Type 

		      This type of sorting allows us to arrange the files as per their type.

		  4.  Sorting by Date of Creation or Modification 

			�   With this type of sorting, files and folders are arranged on the basis of the date they 
were created or the last date on which they were modified by the user.  

C.	 1.	 Aayat can identify the two files correctly by looking at their file extensions. The text document 
will have an extension .docx, while the presentation will have an extension .pptx.

	 2.	 Sahil should use the Cut (Ctrl + X) and Paste (Ctrl + V) commands instead of Copy  
(Ctrl + C) and Paste (Ctrl + V).

Higher Order Thinking Skills (HOTS)
	 1.	 Gaurav is listening to music on his computer system with MP3 file format.

	 2. 	Working with multiple applications allows users to multitask efficiently. For example:

		  ●  A student can research on a browser while typing in a document.

		  ●  A designer can edit images while listening to music, etc.
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Crack The Code

	 1.	 S O R T I N G

	 2.	 E X P L O R E R

	 3.	 F O L D E R

	 4.	 F O R M A T

	 5.	 S T O R A G E

	 6.	 D R I V E

	Word Processor—Tabular Representation

Let's Catch Up (Page 35)

Step 1:	 Insert	
Step 2:	 Table	
Step 3:	 Insert Table	
Step 5:	 OK

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 b 	 3.	 b	 4.	 b
B.	 1.	 right-pointing	 2.	 select	 3.	 rows, columns
	 4.	 organise			   5.	 Spin box
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 T	 5.	 T

Section B (Subjective)

A.	 1.	 A table is a grid of boxes framed by horizontally aligned rows and vertically aligned columns 
that help to organise data. 

	 2.	 To select an entire row, move the mouse pointer outside the left edge of the first cell in the 
row. The pointer will become a black right-pointing arrow. Click to select the entire row.

3.
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	 3.	 To apply a table style, follow the given steps: 
		  Step 1:  Select the table.
		  Step 2:  Click on Design Tab.
		  Step 3:  Click and select the design of your choice.
	 4.	 To enter the data into a table, follow the given steps: 
		  Step 1:  Click in the cell of the table in which you want to enter the data.
		  Step 2:  Type the required data in the cell. In this case, we have typed ‘Riya’. 
		  Step 3: � Press the Tab key from the keyboard to go to the next cell, enter the data in all the 

cells of the table. 
B.	 1.	 Combining two or more adjacent cells in the same row or column is known as merging of 

cells. Cells are merged when a common heading is to be given to two or more columns or 
rows. To merge cells of a table, follow the given steps: 

		  Step 1:  Select the cells that you want to merge.
		  Step 2:  Click on Layout tab.
		  Step 3:  Click on Merge Cells command. 
	 2.	 Word allows you to enhance the look of the table by applying the Borders and Shading 

styles. To apply Border and Shading styles, follow the given steps: 
		  Step 1:  Select the table.
		  Step 2:  Click on the Design tab.
		  Step 3:  Click on down-arrow in Borders.
		  Step 4:  Select Border and Shading.
		  Step 5:  Modify the Style, Color and Width options from the Borders tab.
		  Step 6:  Click on Shading tab. Click the down arrow button of the Fill.
		  Step 7:  Choose the colour of your choice.
		  Step 8:  Click on the OK button.
	 3.	 To resize a table, follow the given steps: 
		  Step 1: � Move the mouse pointer over the table. The Table Resize Handle will appear at the 

bottom right corner of the table. Move the mouse pointer over the Table Resize 
Handle. Mouse pointer converts to two headed cross arrow.

		  Step 2: � Click and drag the mouse diagonally and release the mouse button when you get 
the desired size. 

	 4.	 To change the column width and row height, follow the given steps: 
		  Step 1:  Click on the column or row whose width or height you want to change.
		  Step 2:  Click on the Layout tab.
		  Step 3: � Specify the column width or row height in the Table Column Width or Table Row 

Height spin box.
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C.	 1.	 To make the column in a table automatically fit the contents, follow the given steps: 
		  Step 1: � Click anywhere in the table.
		  Step 2: � Go to the Table Tools tab at the top.
		  Step 3: � Select the Layout tab.
		  Step 4: � Click on the AutoFit command.
		  Step 5: � Select the AutoFit Contents option.
	 2.	 To apply Border and Shading styles, follow the given steps: 
		  Step 1: � Select the table.
		  Step 2: � Click on the Design tab.
		  Step 3: � Click on down-arrow in Borders.
		  Step 4: � Select Border and Shading.
		  Step 5: � Modify the Style, Color and Width options from the Borders tab.
		  Step 6: � Click on Shading tab. Click the down arrow button of the Fill.
		  Step 7: � Choose the colour of your choice.
		  Step 8: � Click on the OK button.

Higher Order Thinking Skills (HOTS)
	 1.	 Using a grid helps quickly create a table by visually selecting rows and columns. It’s fast and 

easy but limited in size and customisation compared to the Insert Table command.
	 2.	 To select a group of cells, click on any of the corner cells to be selected, and without releasing 

the mouse button, drag to select more than one cell. Release the mouse button when all 
the required cells have been selected. 

Crack The Code
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 Word Processor—Mail Merge

Let's Catch Up (Page 45)

Mail Merge is used to send the same letter with different names and addresses so that the same 
letter is addressed to different  recipients. 

Exercise
Section A (Objective)

A.	 1.	 b	 2.	 b	 3.	 d 	 4.	 a
B.	 1.	 Documents		 2.	 Greeting Line		  3.	 Mailings	 4.	 Main
	 5.	 Start Mail Merge
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 T

Section B (Subjective)

A.	 1.	 It is a separate file that contains all the information like names and addresses about the 
recipients of the letter. 

	 2.	 You can make any change in the letter before printing by selecting the Edit Individual 
Documents option from the drop-down list. When you select this option, a new document 
will appear containing all the letters, each on a separate page. 

B.	 1.	 In Mail Merge, the recipient information can be saved in an external file such as an Excel 
spreadsheet, Access database, or any other data file containing details about the recipients. 
This file serves as the “data source” for the merge process.

	 2.	 To preview the letters before printing in Mail Merge, click on the “Preview Results” button 
under the “Mailings” tab. This allows you to see how the merged data will appear in the final 
document before proceeding with printing.  

C.	 1.	 Twinkle should use Mail Merge in Word to create and send the invitations.
	 2.	 You can edit the list of contacts you have entered from the option ‘Edit Recipient List’ from 

‘Start Mail Merge’ group. A box appears to edit and select contacts. 

Higher Order Thinking Skills (HOTS)
	 1.	 To include personalised greetings for each student in the newsletter, you could use Mail 

Merge in Word. 
	 2.	 The Mail Merge feature in Word can help you by automatically merging a list of names and 

addresses with an invitation card template. You just need to create one invitation template, 
and Mail Merge will fill in the names and addresses from your data source (like an Excel file) 
to create personalised invitation cards for each relative, saving time and effort.

4.
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Crack The Code
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 Presentation—Visual Effects

Let's Catch Up (Page 60)

	 1.	 a
	 2.	 a

Exercise
Section A (Objective)

A.	 1.	 b 	 2.	 a 	 3.	 b 	 4.	 b 	 5.	 d 
B.	 1.	 Notes	 2.	 Slide show	 3.	 Transition	 4.	 Normal	 5.	 Slide
C.	 1.	 F	 2.	 F	 3.	 T	 4.	 F	 5.	 F

Section B (Subjective)

A.	 1.	 Transition determines how your presentation moves from one slide to the next. 
	 2.	 As soon as the action button is inserted in the slide an Action Settings dialog box opens.
	 3.	 Entrance, Emphasis, Exit and Motion Paths.
	 4.	 In Slide Sorter View, the user can view more than one slide in a small size (thumbnails) 

horizontally on the screen. 

5.
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B.	 1.	 In Normal view (by default) a blank slide appears on the workspace. It enables a user to 
make presentation as required. It is the editing mode where you’ll work most frequently to 
create your slides. It is helpful while designing presentation of large number of slides. It sets 
the standard for viewing slides. 

		  It shows the current slide, the outline and the Notes pane. 
	 2.	 It is a tool that shows a list of animated objects on a slide. In this pane, you can reorder the 

animations, change the timing, start options and the duration by clicking on the down arrow 
of each applied animation effect. 

	 3.	 To add or modify timing of the animation effects, follow the given steps: 
		  Step 1:  Click on the Animations tab.
		  Step 2:  Click on the Start down button and select any one option.
		  Step 3: � Enter the number of seconds that you want the animation to run in the Duration 

box.
		  Step 4:  Click on Move Earlier or Move Later to change the order of animation. 
C.	 1.	 Tanya should use the Slide Sorter View in PowerPoint. This view displays all the slides in 

a thumbnail layout, making it easy to review the sequence and rearrange slides by simply 
dragging and dropping them into the correct order.

	 2.	 Swapnil should use the Notes Pane in PowerPoint to add his speaking notes. These notes are 
visible in the Presenter View during the slideshow but do not appear on the slides shown to 
the audience. This helps him refer to key points while presenting without displaying them 
publicly.

Higher Order Thinking Skills (HOTS)
	 1.	 Yes, animations make a presentation more lively and interesting by drawing attention and 

highlighting key points. When used properly, they keep the audience engaged and help 
present information clearly.

	 2.	 Do it yourself.

Crack The Code
	 1.	 Slide Sorter 
	 2.	 Outline View
	 3.	 Notes Page
	 4.	 Reading View
	 5.	 Normal View
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Worksheet 1  (Based on chapters 1 to 5)

A.	 1.	 Desktop, Laptop
	 2.	 PDP-11, PDP-8
	 3.	 ATM,  Microwave
	 4.	 Smartphone, Smartwatch
B.	 1.	 A wildcard is a special character which is used to represent one or more characters.
	 2.	 Division of cells into two or more sub-cells is known as splitting of cells. 
	 3.	 Mail Merge is a feature of Word processor like Word, in which names and addresses of 

different recipients are merged in one document and each pair of name and address is 
merged with a copy of particular letter, so that the same letter is addressed to different 
recipients. 

	 4.	 Notes pane is the area where a speaker can write notes for himself.
C.		  1.	 Insert	 2.	 Layout	 3.	 Layout	 4.	 Layout		  5.  Design
D.	 1.	 Hybrid	 2.	 Assembler	 3.	 Right-click	 4.	 Data Source		  5.	 Animation
	 6.	 Slide Sorter View

(Based on chapters 1 to 5)
Test Sheet 1

Section A 

A.	 1.	 a	 2.	 a	 3.	 c	 4.	 b	 5.	 a
	 6.	 c	 7.	 c	 8.	 c
B.	 1.	 microcomputer	 2.	 partitions	 3.	 audio	 4.	 Merging
	 5.	 Mailings			   6.	 Animation Pane
C.	 1.	 F	 2.	 F	 3.	 F	 4.	 F	 5.	 T	 6.	 T

Section B 

A.	 1.	 A microcomputer is a type of computer that has one microprocessor as its processing unit. 
It is a small and less expensive digital computer. This type of computer is made to be used 
by a single user at a time. A Microcomputer is also called a Personal Computer (PC).

	 2.	 Data on a computer can be arranged in the form of files or folders. This saves time and 
prevents errors later on. 

	 3.	 Table Styles is a feature with which a user can format the entire table quickly.
	 4.	 The command used to add an address list is Select Recipients in the Mailings tab.
	 5.	 Slide Sorter View, the user can view more than one slide in a small size on the screen.
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	 6.	 Animation facilitates the display of presentation of contents in a special sequence of typical 
effects leading to interesting and lively presentation. It includes multiple types of media 
control like graphics, video, sound, music, movies, etc.

B.	 1.	 Digital computer refers to a computer that uses digits (binary numbers 0’s and 1’s) to 
generate, process, and display data. The results produced by digital computers are more 
accurate than those of analog computers. Two examples of digital computers are laptops 
and smartphones.

	 2.	 File Explorer is the default file management application in Windows operating systems. File 
Explorer helps us organise and manage files and folders. 

	 3.	 To insert a table, follow these steps:
		  Step 1: Click on the Insert tab.
			  Step 2: Click on the Table drop-down arrow.
		  Step 3: �Click on the top left corner of the grid and drag the mouse to highlight the number 

of columns and rows you want in the table.
		  The table will be inserted into the document.
	 4.	 The steps to create a Data Source in Mail Merge are:
		  Step 1: Click on Mailings tab. 
		  Step 2: Click on Select Recipients command. 
		  Step 3: Select the ‘Type a New List’ option. 
		  Step 4: Add the details of the recipients. 
		  Step 5: Click on OK button. 
		  Step 6: In File name box, type the name of the list to save.
		  Step 7: Click on the Save button.
	 5.	 Action buttons is a way to add interactivity and navigation to a presentation. There are 12 

different types of action buttons available in PowerPoint. 
	 6.	 The steps to import data from other applications into PowerPoint are:
		  Step 1: Click on the Insert tab. 
		  Step 2: Click on the Object command.
		  Step 3: Select the Create from file option if you want to import an existing file. 
		  Step 4: Click on the Browse button. 
			         The Browse dialog box appears.
		  Step 5: Navigate to the location where you have saved the file and select the file. 
		  Step 6: Click on the OK button. 
		  Step 7: �Select the Display as icon check box if you want to display the imported file as an 

icon. 
		  Step 8: Click on the OK button.

 Scratch Programming—Game Creation

Let's Catch Up (Page 73)

	 1.	 Sprite
	 2.	 Script

Exercise
Section A (Objective)

A.	 1.	 b 	 2.	 c 	 3.	 b 	 4.	 c 	 5.	 b
B.	 1.	 Costumes	2.	 120	 3.	 Stage	 4.	 Go	 5.	 Code
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 F	 5.	 T

Section B (Subjective)

A.	 1.	 To add Pen Blocks, follow the given steps: 
		  Step 1: Click on the Add Extension button.
		  Step 2: Click on Pen option. The Pen block is added to the Code tab.
	 2.	 pen up block
	 3.	 Polygons are enclosed 2D shapes with three or more straight lines. Examples of polygons 

are triangle, square, rectangle, quadrilateral, pentagon, octagon, etc.
	 4.	 To set the colour of the pen to a colour of your choice from the drop-down menu. 
B.	 1.	 Script is a collection of a number of stacked blocks. It gives stepwise instructions to a Sprite 

to do something on the stage. 
		  To create a script, you drag blocks from the Blocks Palette and snap them together in the 

Code Area

	 2.	 ● � If…then block: In this block if the condition is true, the blocks inside conditional block 
will run. If the condition is false, the blocks inside conditional block will not run. Then the 
blocks outside the conditional block will run. 

		  ● � If…then…..else block: In this block if the condition is true, the blocks inside then condition 
will run. If the condition is false, the blocks inside else condition will run. 

	 3.	 To draw a pattern, we use Stamp block from the Pen blocks menu. The Stamp block duplicates 
Sprite’s image onto the stage.

	 4.	 ●  The Repeat block is used to run a set of instructions for a specified number of times. 

		  ●  The Repeat Until block is used to run a set of instructions until a condition is satisfied. 
C.	 1.	 i.		  2. iv.

6.
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 Scratch Programming—Game Creation

Let's Catch Up (Page 73)

	 1.	 Sprite
	 2.	 Script

Exercise
Section A (Objective)

A.	 1.	 b 	 2.	 c 	 3.	 b 	 4.	 c 	 5.	 b
B.	 1.	 Costumes	2.	 120	 3.	 Stage	 4.	 Go	 5.	 Code
C.	 1.	 T	 2.	 F	 3.	 F	 4.	 F	 5.	 T

Section B (Subjective)

A.	 1.	 To add Pen Blocks, follow the given steps: 
		  Step 1: Click on the Add Extension button.
		  Step 2: Click on Pen option. The Pen block is added to the Code tab.
	 2.	 pen up block
	 3.	 Polygons are enclosed 2D shapes with three or more straight lines. Examples of polygons 

are triangle, square, rectangle, quadrilateral, pentagon, octagon, etc.
	 4.	 To set the colour of the pen to a colour of your choice from the drop-down menu. 
B.	 1.	 Script is a collection of a number of stacked blocks. It gives stepwise instructions to a Sprite 

to do something on the stage. 
		  To create a script, you drag blocks from the Blocks Palette and snap them together in the 

Code Area

	 2.	 ● � If…then block: In this block if the condition is true, the blocks inside conditional block 
will run. If the condition is false, the blocks inside conditional block will not run. Then the 
blocks outside the conditional block will run. 

		  ● � If…then…..else block: In this block if the condition is true, the blocks inside then condition 
will run. If the condition is false, the blocks inside else condition will run. 

	 3.	 To draw a pattern, we use Stamp block from the Pen blocks menu. The Stamp block duplicates 
Sprite’s image onto the stage.

	 4.	 ●  The Repeat block is used to run a set of instructions for a specified number of times. 

		  ●  The Repeat Until block is used to run a set of instructions until a condition is satisfied. 
C.	 1.	 i.		  2. iv.

6.
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Higher Order Thinking Skills (HOTS)
	 1.	 Loops reduce repetition by running the same set of blocks multiple times, making it easier 

to draw complex shapes with less code.
	 2.	 To draw a house in Scratch using pen blocks:

		  ●  First, use the “pen down” block to start drawing.

		  ●  Use “repeat 4” with move and turn 90 degrees to draw the square base.

		  ●  After the square, move the sprite to the top of the square.

		  ● � Then use move and turn blocks to draw the triangular roof by turning 45 degrees, moving 
to form one side, turning 90 degrees, and drawing the other side.

		  ●  Finally, use “pen up” to stop drawing.
		  This sequence will create a simple house shape with a square base and a triangle on top 

representing the roof.

Crack The Code

Upload Sprite

Surprise

Choose a Sprite

Paint

 HTML—An Introduction

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 b 	 3.	 c 	 4.	 b	 5.	 d 
B.	 1.	 F	 2.	 F	 3.	 T	 4.	 F	 5.	 T
C.	 1.	 markup	 2.	 empty	 3.	 body	 4.	 inline	 5.	 background-image

7.
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Section B (Subjective)

A.	 1. 	HTML5		  2.  Selector	      3.	HTML element		  4.	 Attribute
B.	 1.	 HTML stands for Hypertext Markup Language. It is a markup language that describes the 

structure of a web page. It allows us to create web pages that contain paragraphs, headings, 
links and block quotes. 

	 2.	 <head>
		    <link rel=”stylesheet” type=”text/css” href=”mystyle.css”>
		  </head>
	 3.	 An internal style sheet is commonly used when one web page has a unique style. For example: 
		  <head> 
		  <style> 
		  body{background-color:green; color:white;} 
		  </style> 
		  </head> 
		  <body> 
		  Text in white colour 
		  </body>

C.	 1.  Syntax to create a style in CSS is: 
		  selector{property1:value1; property2:value2; … …} 
	 2.	 The background colour value is written inside double quotes, which is incorrect.
		  Correct code: 
		  body {background-color:green}
	 3.	 F5 (to refresh the page)

Higher Order Thinking Skills (HOTS)
	 1.	 Separating HTML (content) from CSS (presentation) makes web design easier to manage, 

update, and scale.

		  ●  Developers: Update design in one CSS file for many pages.

		  ●  Users: Faster loading, consistent layout.
		  Example: Changing font style site-wide only needs one CSS edit.

		  2.	 ●  Inline CSS: Good for small, quick changes but hard to maintain.

		    ●  External CSS: Better for large sites, easier to update and ensures consistency.
		  Use inline for testing or emails; external for scalable, professional websites.
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 Online Surfing and Cybersecurity

Let's Catch Up (Page 113)

	 a.	 T		  b.	 F	 c.	 T

Exercise
Section A (Objective)

A.	 1.	 c 	 2.	 c 	 3.	 c 	 4.	 b 	 5.	 b
B.	 1.	 Chatting	 2.	 Cyber threat	 3.	 Video conferencing
	 4.	 audios, videos, Still images	 5.	 Cloud
C.	 1.	 T	 2.	 T	 3.	 F	 4.	 T	 5.	 T

Section B (Subjective)

A.	 1.	 The News Admin keeps a check on the comments of the participants. He decides when to 
stop a discussion as well as approve the comments or articles before they are posted on the 
newsgroup page. 

	 2.	 The most common and popular VoIP services used are Skype and GoogleTalk. 
	 3.	 Cloud storage is a service where the users are able to store and manage data on a remote 

server. 
	 4.	 a.  Voice over Internet Protocol
		  b.  Uniform Resource Locator

8.
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B.	 1.	 This refers to the process of changing the data going into or out of a computer. For example, 
a student breaks into his/her university’s grade recording system and changes the grades 
he/she earned in the last semester or class, thus raising his/her grade point average.

	 2.	 The various reasons for increased cybercrimes are: 

		  ●  Increasing use of Internet 

		  ●  Lack of awareness 

		  ●  Multi-pronged attacks 
	 3.	 The use of VoIP has many advantages like: 

		  ●  Low cost of operations 

		  ●  Less communication and infrastructure cost 
		  VoIP services also have some disadvantages like: 

		  ●  Loss of data 

		  ●  Less reliable 
	 4.	 This refers to a fraud in which scanners are used to steal the electronic serial numbers of 

cellular phones, which may be used for billing purposes and making broadcast calls. With 
stolen serial numbers, clones can be made to make free calls that are billed to the owner of 
the original cell phone. 

C.	 1.	 John can use Cloud storage services like Google Drive or Dropbox to store and share the 
large file with his friend over the Internet.

	 2.	 Two popular video conferencing tools are:

		  ●  Google Meet

		  ●  Zoom

Higher Order Thinking Skills (HOTS)
	 1.	 Hacking is not always illegal. There are two types:

		  ●  Ethical hacking, which is legal and done with permission to find and fix security issues.

		  ●  Illegal hacking, which involves unauthorised access to data and is a cybercrime.
		  So, hacking can be legal or illegal depending on its purpose and consent.
	 2.	 Internet services like email and cloud storage have improved business operations by:

		  ●  Making communication faster and more efficient through email.

		  ●  Allowing easy file sharing and access from anywhere using cloud storage.
		  This helps businesses save time, reduce costs, and work more collaboratively and flexibly.
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 E-mail—An Introduction

Let's Catch Up (Page 121)

		  Two features of an e-mail are:
		  a. Ability to attach the files along with the message 
		  b. Ability to store information such as messages and contact lists 

Exercise
Section A (Objective)

A.	 1.	 c 	 2.	 c 	 3.	 d 	 4.	 b 	 5.	 b 
B.	 1.	 Outbox	 2.	 Verification	 3.	 Compose	 4.	 Facial expressions
	 5.	 Attachments
C.	 1.	 T	 2.	 F	 3.	 T	 4.	 F	 5.	 T

9.
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Section B (Subjective)

A.	 1. 	Google Talk, Messenger, and LiveChat 
	 2.	 Spam folder.
		  The e-mails are called spam or junk mails
	 3.	 The Trash folder contains deleted e-mails that can be restored or permanently removed.
	 4.	 The first person to send an e-mail across a network was Ray Tomlinson 
B.	 1.	 The four important fields in the New Message window are:

		  ●  To: The main recipient’s e-mail address is entered here.

		  ● � Cc (Carbon Copy): Used to send a copy of the e-mail to other recipients who are not the 
main audience.

		  ● � Bcc: Bcc stands for Blind Carbon Copy. It is marked to the e-mail address when you do 
not want others to see to whom the e-mail has been sent. 

		  ●  Subject: A short title or heading that tells the recipient what the e-mail is about.
	 2.	 An Electronic mail or e-mail can be defined as the process of exchanging messages 

electronically through a communication network by using computer. 
		  E-mail has several features. Some of them are as follows: 

		  ●  Ability to attach the files along with the message 

		  ●  Ability to store information such as messages and contact lists 
	 3.	 You should always close your e-mail account after checking e-mails. This is known as Sign 

out or logout. It is very important to sign out from your account so that no one else using 
the computer can read your e-mails or send unwanted e-mails from your e-mail account. 

	 4.	 An emoticon is a combination of characters used to express emotions.
		  Example: :) used for Happy
		  An acronym is a short form made from the initials of a phrase.
		  Example: LOL – Laughing Out Loud.
C.	 1.	 To recover a deleted e-mail, follow the given steps:
		  Step 1: Open your e-mail account.
		  Step 2: Go to the Trash or Bin folder from the menu.
		  Step 3: Find and select the deleted e-mail you want to recover.
		  Step 4: Click on the “Move to Inbox” or “Restore” option.
	 2.	 To send a photo and a document via Gmail, follow the given steps:
		  Step 1: Open your Gmail account.
		  Step 2: Click the “Compose” button to start a new e-mail.
		  Step 3: Enter the recipient’s e-mail address, subject, and message.
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		  Step 4: Click on the Attach files button to attach files.
		  Step 5: Select the photo and document from your device.
		  Step 6: After the files are attached, click the “Send” button.

Higher Order Thinking Skills (HOTS)
	 1.	 Email is more formal and is used for professional or official communication, allowing 

attachments, longer messages, and detailed conversations. In contrast, instant messaging 
and social media are faster and more casual, mainly used for quick chats, updates, or public 
sharing. Email also supports structured communication, while messaging is real-time and 
brief.

	 2.	 E-banking has made banking more convenient, faster, and accessible. It allows users to 
perform transactions, pay bills, check balances, and transfer money anytime and anywhere 
without visiting a bank. This has reduced paperwork, saved time, and improved customer 
service in the banking sector.

Crack The Code
		  Do it yourself.

  More on Internet

Let's Catch Up (Page 139)

	 a.	 Debit or Credit Card 
	 b.	 Net Banking 
	 c.	 E-Wallet 

Exercise
Section A (Objective)

A.	 1.	 a 	 2.	 b 	 3.	 a 	 4.	 a 
B.	 1.	 Podcast	 2.	 E-Wallet	 3.	 e-Commerce	 4.	 Blogger
C.	 1.	 F	 2.	 T	 3.	 F	 4.	 T

Section B (Subjective)
A.	 1.	 You can share a file or folder in Google Drive by using the “Share” option.
	 2.	 The process of purchasing products online is called online shopping. You can purchase 

almost everything online. 

10.
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	 3.	 Debit or Credit Card and Cash on Delivery (COD)
B.	 1. 	To share a document, follow the given steps: 
		  Step 1: Select the file that you want to share.
		  Step 2: Click on the More actions button and then select the Share option.
		  Step 3: Select the Share option.
		  Step 4: �Type the e-mail addresses or names of the people you want to share within the Add 

people, groups and calendar events textbox. 
		  Step 5: Type the message in the Message box.
		  Step 6: Click on the Send button.
	 2.	 E-commerce has several advantages. Some of them are: 

		  ● � E-commerce websites are operational round the clock, so we can purchase an item at 
any time of the day. 

		  ●  It saves time and travel expenses. 
		  E-commerce provides several advantages, but it also has some disadvantages which are as 

follows: 

		  ●  There is no assurance of the quality. 

		  ●  There are high possibilities of online fraud.
	 3.	 E-wallet or Electronic wallet refers to a digital wallet that is used to make payments online. We 

need to add money from the bank account to the e-wallets before using it. Most e-commerce 
websites provide their own e-wallet. GooglePay, Paytm, PayPal, Bhim, PhonePe, and Airtel 
Money are the most commonly used Payment Service Providers (PSP). 

C.	 1.	 Amazon, Flipkart and Myntra
	 2.	 To upload a file, follow the given steps: 
		  Step 1: Click on the New button.
		  Step 2: Select the File upload option to upload a file.
		  Step 3: Navigating a location where the file is stored.
		  Step 4: Select the file which you want to upload. 
		  Step 5: Click on the Open button.
		  The selected file gets successfully uploaded and appears as a thumbnail under My Drive 

section on Google Drive. 

Higher Order Thinking Skills (HOTS)
	 1.	 If I want to purchase a book online, I would choose UPI or Debit/Credit Card as the payment 

method because:

		  ●  It is secure, especially on trusted websites.
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		  ●  The transaction is instant and easy.

		  ●  I can track my payment easily through bank alerts or apps.
	 2.	 To create a short podcast about a school event, I would structure it like this:
		  a.  Introduction – Greet listeners and introduce the event name and purpose.
		  b.  Main Highlights – Talk about the key moments (performances, speeches, winners).
		  c.  Interviews/Sound Clips – Include short student or teacher reactions to make it engaging.
		  d.  Conclusion – Thank listeners, share a fun fact or upcoming event, and sign off cheerfully.

Crack The Code
		  Do it yourself.

Worksheet 2  (Based on chapters 6 to 10)

A.	 1.	 Backdrop is a background of the stage.
	 2.	 Sprite is an object or actor that we see on the Scratch stage. 
	 3.	 Coding Area is the area where we pick and drop the blocks from the Blocks Palette to create 

a script/program.
	 4.	 Go Button is the green flag, used to run a Scratch program. 
B.	 1.	 Adobe Dreamweaver 		  Amaya
	 2.	 <BR> 				    <HR>
	 3.	 E-Greetings  			  E-Banking
	 4.	 Net B	anking 			  E-Wallet
C.	 1.	 Set pen color to
	 2.	 Stamp
	 3.	 Web browser
	 4.	 Element
	 5.	 Attribute
	 6.	 Social networking
	 7.	 Cloud storage
	 8.	 Spam
D.	 1.	 HyperText Markup Language
	 2.	 Standard Generalized Markup Language
	 3.	 Automated Teller Machine
	 4.	 One Time Password
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	 5.	 Carbon Copy
	 6.	 Blind carbon copy
	 7.	 Voice-over-Internet Protocol 
	 8.	 Common Business Oriented Language

(Based on chapters 6 to 10)
Test Sheet 2

Section A 

A.	 1.	 a	 2.	 c	 3.	 b	 4.	 b	 5.	 a
	 6.	 b	 7.	 c	 8.	 c	
B.	 1.	 blog	 2.	 sound	 3.	 Head	 4.	 data diddling 
	 5.	 Sent	 6.	 Drive
C.	 1.	 F	 2.	 F	 3.	 F	 4.	 T	 5.	 F	 6.	 T

Section B 

A.	 1.	 Google Docs option is used to create a document similar to a Word document on Google 
Drive. 

	 2.	 Carding refers to the process of stealing credit card numbers online, to be resold or used to 
charge merchandise against the victim’s account.

	 3.	 Repeat block is used to draw a pentagon.
	 4.	 HTML is a markup language that describes the structure of the web page.
	 5.	 Hacking is the practice of modifying computer hardware and software to accomplish a goal 

outside of the creator’s original purpose.
	 6.	 Acronyms work like shorthand for Internet users as it saves typing time.
B.	 1.	 Blogging is the act of writing and maintaining a blog, which includes photography and other 

media that are self-published online. Readers of blog can also comment. When more readers 
comment, the blog becomes more popular. Podcasts and Photologs are types of blogs.

	 2.	 Blocks are puzzle piece shapes that are used to give instructions to the computer.
		  Two blocks are: Control and Events.
	 3.	 WYSIWYG Editor:
		  WYSIWYG stands for What You See Is What You Get. This type of editor allows the developer 

to see what the end result will look like when the document is created. These editors provide 
various tools and graphical interfaces where the web pages are designed. Examples of 
WYSIWYG editors are Adobe Dreamweaver, Amaya and Google Web Designer. 
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		  Text Editor:
		  We can create HTML documents using normal text editors like Notepad or Wordpad. The 

user should have a proper knowledge of the HTML commands to develop a web page.
	 4.	 The differences between hacking and cracking are:
		  Hacking
	 	 •  Practice of modifying computer hardware and software.
	 	 •  People engaged are called as hackers.
		  Cracking
	 	 •  Process of stealing personal information.
	 	 •  People engaged are called as crackers.
	 5.	 Inbox is the folder where all e-mails that you have received from others are stored whereas 

Outbox is the folder where all outgoing e-mails are temporarily stored. Once all the e-mails 
have been sent, the Outbox folder gets empty.

	 6.	 A podcast is like an online on-demand radio show. It can be considered as a medium through 
which recorded audio information is distributed over the Internet, unlike a radio show where 
the show is broadcast live. We can listen to these audio files whenever we want. You can 
listen to podcasts directly from the websites they are posted on or can also subscribe to 
them using software like iPodder and iTunes. 


